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환영합니다!아이유에디터공식메뉴얼입니다.

• 한글매뉴얼 PDF다운받기 : http://iueditor.org/static/IUEditorManualKo.pdf

프로그램은아래홈페이지에서다운받아주세요.

• IUEditor Homepage : http://iueditor.org

• IUEditor Facebook Page (Korean): https://www.facebook.com/iueditor

소개 Introduction 1
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2 소개 Introduction



CHAPTER 1

아이유에디터란? What is IUEditor?

아이유에디터 IUEditor (이하 아이유에디터) 는 디자인 & 개발 프로세스를 단순화하는데 최적화되어 있는 웹에
디터입니다.

1.1 장점 Advantages

• 아이유에디터는 GUI기반프로그램으로사용자가코딩없이프로토타입을디자인할수있습니다.

• 하나의 프로젝트 파일로 여러 크기의 디바이스에 대응할 수 있는 프로덕트나 웹사이트를 개발할 수 있습
니다.

• 파이썬 Python과같은백엔드 Backend와통합되어있습니다.

1.2 가치 Values

• 아이유에디터는디자이너가퍼블리셔의도움없이개발자와협업할수있게하여,여러분의팀,회사의시간과
비용을절약할수있습니다.

• 여러분의 회사나 팀이 프로덕트나 웹사이트를 빠르게 출시할 수 있게 하여, 린 프로세스 Lean Process를
도입하고더나은결과물을만들수있습니다.

1.3 조금더 ...

• Javascript매뉴얼은 http://cdn.iueditor.org/js/readme.html에있습니다.

3
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4 Chapter 1. 아이유에디터란? What is IUEditor?



CHAPTER 2

구동환경 Environment

아이유에디터는Mac OS X 10.14(모하비)이상의환경에서만동작합니다.

브라우저지원 : Chrome, Safari, Firefox, Opera - current / IE 9.0이상

5
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CHAPTER 3

메뉴 Menu

3.1 IUEditor메뉴바 Menu Bar에대한설명입니다.

3.2 아이유에디터 IUEditor

• About IUEditor :사용자 IUEditor의버젼정보를보여줍니다.

• Preference :사용자 IUEditor의환경설정 Preference창을엽니다.
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3.3 파일 File

• New Project :새프로젝트만들기창을띄웁니다.

• Open : Finder에서오픈할프로젝트를찾습니다.

• Open Recent :최근사용한 IU프로젝트파일을오픈합니다.

• Save :현재프로젝트파일을저장합니다.

• Save As :현재프로젝트파일을다른이름으로저장합니다.

• Close :현재프로젝트를닫습니다.

3.4 프로젝트 Project

• Build :프로젝트를브라우저로빌드합니다.상단툴바의빌드실행버튼과동일한기능입니다.

• Build Clean :빌드데이터를지웁니다.빌드에오류가있을때문제를해결할수있습니다.

• Stop :빌드를멈춥니다.

• Project Setting :프로젝트셋팅 Project Setting패널을띄웁니다.

• Project Code :프로젝트코드 Project Code패널을보여줍니다.
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• Refresh Page :페이지를새로고침합니다.캔버스에오류가있을때문제를해결할수있습니다.

3.5 뷰 View

• Show Tab Bar :탭바를보여줍니다.

• Show All Tabs :전제탭을보여줍니다.

• ZoomOut :캔버스를확대합니다.

• ZoomIn :캔버스를축소합니다.

• Outline :위젯외곽선을보여줍니다.

• Ruler :스테이지에룰러요소를보여줍니다.

• Guide :설정해놓은가이드라인을보여줍니다.

• Tracing :이미지트레이싱기능을 on/off합니다.

• Enter Full Screen :전체화면으로전환합니다.

3.5. 뷰 View 9
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3.6 창Window

• Event :이벤트패널 Event Panel을보여줍니다.

• Resource :리소스패널 Resource Panel을보여줍니다.

• Memo :메모패널 Memo Panel을보여줍니다.

• Manage Custom Widgets :커스텀위젯관리패널 Manage Custom Widgets Panel을보여줍니다.

• Log :로그패널을보여줍니다.

3.7 지원 Help

• Search : IUEditor의기능을검색합니다.

• Documentation : IUEditor메뉴얼사이트를방문합니다.

• Ask IUEditor :프로그램에대한문의를할수있는웹페이지로이동합니다.

• Acknowledgements :프로그램에사용된 API에대한정보를보여줍니다.
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CHAPTER 4

상단툴바 Top Toolbar

상단툴바는커맨드 Command /탭메뉴 Tab Menu /스테이지 Stage영역으로구분됩니다.
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4.1 커맨드 Command

커맨드영역은프로젝트레벨에서동작하는기능들로구성되어있습니다.

• 빌드 실행 버튼 : 현재 스테이지에 있는 요소들을 기준으로 HTML/CSS/JS 파일을 생성합니다. 빌드 생성
전아이유프로젝트를로컬에저장해야만빌드가가능합니다.

• 서버 중지 버튼 :로컬호스트서버를중지합니다.

• 빌드 타입 설정 버튼 : 빌드를 실행할 타입을 설정합니다. 생성한 프로젝트 타입에 따라 옵션이 달라집
니다.

• 디자인 / 디벨롭 / 프로토타입 모드 변경 버튼 :프로그램기본설정은디자인모드 Design Mode입니
다.이버튼을눌러디자인모드 Design Mode,디벨롭모드 Develop Mode ,프로토타입모드 Prototype Mode
로각각변경할수있습니다.

4.2 탭메뉴 Tab Menu

상단 툴 바 중앙에 위치한 탭 메뉴 영역에서는 스타일 / 속성 / 텍스트 / 트랜스폼 / 마우스-오버 / 링크 탭 메뉴가
있습니다.각탭메뉴를선택하면,상단툴바하단의프로퍼티패널에보여집니다.

• 스타일 탭 Style Tab :선택한위젯의라운딩 /보더 /박스쉐도우 /투명도 /배경이미지등을설정할수
있습니다.

• 속성 탭 Property Tab : 선택한 각 위젯의 개별 속성을 변경할 수 있습니다. 각 위젯 별로 설정 가능한
항목이다릅니다.

• 텍스트 탭 Text Tab :폰트패밀리 /두께 /크기 /컬러 /행간 /자간 /제목텍스트 /정렬등을설정할수
있습니다.

• 트랜스폼 탭 Transform Tab : 선택한 위젯의 회전 값 Rotation 값 등을 설정하여 형태를 변형시킬 수
있습니다.
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• 마우스-오버 탭 Mouse-Over Tab : 선택한 위젯이 마우스 오버 상태일 때 변화하는 값을 설정 할 수
있습니다.

• 링크 탭 Link Tab :선택한위젯에링크 Hyperlink를설정할수있습니다.

4.3 스테이지 Stage

• 트레이싱 Tracing :트레이싱은디자인이미지를스테이지배경에추가하여,좀더빠른작업이가능하도
록도와줍니다.트레이싱아이콘을눌러트레이싱모드를 on/off시킬수있으며,트레이싱이미지팝업에서
좀더세세한조정이가능합니다.

• 페이지 설정 Page Setting :현재작업중인페이지의너비 /미디어쿼리등을변경합니다. (미디어쿼리
팝업을열어새로운쿼리를생성하거나,기존미디어쿼리를복사하여생성할수도있습니다. )

• 줌 Zoom :작업중인페이지의줌-인/아웃을설정합니다.

4.3. 스테이지 Stage 13
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CHAPTER 5

중앙툴바 Middle Toolbar

중앙 툴바는 캔버스 바로 상단에 위치하며, 새로고침 / 포지션 / 프레임 / 배경컬러 / 위젯 보기 버튼 영역으로

구분됩니다.
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5.1 새로고침 Refresh

현재캔버스를새로고칩니다.

5.2 포지션 Position

선택된 요소의 포지션을 설정합니다. (단위를 % 로 바꿀 경우, x/y 값은 드래그로 변경되지 않으며 w/h 값 역시
드래그로변경되지않습니다.)

• 포지션 Position :위젯의포지션을 Absolute, Relative, Fixed중한가지로설정합니다.

• 서브 포지션 Sub Position :위젯의포지션기준을무엇으로할지서브포지션을설정합니다.

• 정렬 버튼 Align Button :위젯을가운데로맞춥니다.여러위젯을선택하여정렬할수있습니다.

• 포지션 속성 설정 팝업 Position setting popup : 요소의 포지션 가운데 고정 Fixed Center Posi-
tion,오버플로우 Overflow, z-index속성을변경할수있습니다.

• x 좌표 입력필드 & 스텝퍼 X position input field & Stepper :요소의 x좌표를직접입력하
거나,스텝퍼를이용하여 1px씩조절합니다. px또는 %로단위를변경할수있습니다.

• y 좌표 입력필드 & 스텝퍼 Y position input field & Stepper :요소의 y좌표를직접입력하
거나,스텝퍼를이용하여 1px씩조절합니다. px또는 %로단위를변경할수있습니다.

5.3 프레임 Frame

선택된요소의높이와너비값을설정합니다.

• Width 값 입력필드 & 스텝퍼 Width value input field & Stepper :요소의 width값을직접
입력하거나,스텝퍼를이용하여 1px씩조절합니다. px또는 %로단위를변경할수있습니다.

• Height 값 입력필드 & 스텝퍼 Height value input field & Stepper : 요소의 height 값을
직접입력하거나,스텝퍼를이용하여 1px씩조절합니다. px또는 %로단위를변경할수있습니다.

• 최소/최대 크기 설정 팝업 Min/Max-width & Min/Max-height setting popup : 요소의 최

소/최대높이또는너비를설정할수있습니다.

5.4 배경컬러 Background Color

선택된요소의배경색을선택하거나투명값으로설정할수있습니다.

5.5 위젯보기버튼 Show Widget Button

버튼을 눌러 오른쪽에 위젯 패널을 보이게 하고 숨깁니다. 위젯 패널에는 아이유에디터에서 사용 가능한 모든
위젯들보여집니다. IU WIDGETS탭과 CUSTOM WIDGETS탭으로나뉘어있습니다.

Go To Widget Panel.
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CHAPTER 6

위젯패널Widget Panel

위젯툴바는화면오른쪽에위치하며중앙툴바의오른쪽끝에있는 Show/Hide위젯토글버튼으로보여주고감출
수있습니다.아이유위젯 /커스텀위젯 탭으로구분됩니다.

6.1 아이유위젯 IU Widgets
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IU WIDGETS탭에서는아이유에디터에서사용가능한모든위젯들이보여집니다.기본적으로박스 /텍스트 /이
미지 /셀위젯을제공하며,웹페이지에서활용할수있는다양한위젯을지원합니다. Base, Complex, Programming
그룹으로구분되어있습니다. Show/Hide버튼으로각그룹의위젯목록을펼치고접을수있습니다.오른쪽클릭
으로위젯의상세정보를확인할수있습니다.

기본위젯에대해알아보기 Go To Widget Property.

6.2 커스텀위젯 Custom Widgets

CUSTOM WIDGETS 탭에서는 위젯 불러오기 로 불러온 커스텀 위젯들이 보여집니다. 커스텀 위젯이 속한 그룹
명으로 구분되어 있으며 Show/Hide 버튼으로 각 그룹의 위젯 목록을 펼치고 접을 수 있습니다. 드래그 앤 드롭
이나더블클릭하여위젯을캔버스에추가할수있습니다.오른쪽클릭으로커스텀위젯의상세정보를확인할수
있습니다.상세정보는위젯관리패널 에서수정할수있습니다.

• 새로고침 버튼 Refresh Button :커스텀위젯라이브러리를최신상태로업데이트합니다.

• 검색 영역 Search Field :커스텀위젯을이름이나태그로검색합니다.

• 확대/축소 버튼 Zoom in/Zoom out Button :커스텀위젯의섬네일을확대/축소합니다.

커스텀위젯불러오기에대해알아보기 Go To Manage Custom Widgets Panel.
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CHAPTER 7

네비게이션 Navigation

네비게이션영역은캔버스바로좌측에위치하며,스트럭쳐 /페이지 /컴포지션 영역으로구분됩니다.
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7.1 스트럭쳐 Structure

현재선택한페이지에속한요소들 (섹션,헤더,푸터,페이지컨텐트,위젯등)의구조를트리형태로보여주는패널
입니다.요소를삭제하거나,드래그앤드롭으로위치를이동할수도있으며,새로운섹션을추가할수있습니다.
스트럭쳐에추가된요소들의이름은사용자가원하는이름으로수정가능합니다.

• 팝업 추가 버튼 Add New Popup Button :새로운팝업을추가합니다.

• 패널 추가 버튼 Add New Panel Button :새로운패널을추가합니다.

• 섹션 추가 버튼 Add New Section Button :새로운섹션을추가합니다.

• 삭제 버튼 Delete Button :선택된위젯을삭제합니다.

7.2 페이지 Pages

프로젝트에서사용되는모든페이지들을관리하는패널입니다.새로운페이지/폴더를생성하거나삭제할수있
습니다. 또한 페이지 설정을 통해 페이지의 레이아웃이나 정보를 변경할 수 있습니다. 페이지에 추가된 요소들의
이름은사용자가원하는이름으로수정가능합니다.

• 커스템 페이지 추가 버튼 Add New Custom Page Button :새로운템플릿페이지를추가합니다.

• 페이지 추가 버튼 Add New Page Button :새로운페이지를추가합니다.

• 그룹 추가 버튼 Add New Group Button :새로운페이지그룹을추가합니다.

• 삭제 버튼 Delete Button :선택된페이지나그룹을삭제합니다.

페이지에 마우스 오버시 해당 페이지의 설정을 할 수 있습니다. 페이지 레이아웃이나 기타 해당하는 페이지의
속성을정합니다.

7.3 컴포지션 Compositions

임포트 위젯이나 헤더, 푸터, 사이드바로 임포트할 컴포지션을 관리하는 패널입니다. 새로운 컴포지션/폴더를 생
성하거나삭제할수있습니다.

• 커스텀 컴포지션 추가 버튼 Add New Custom Composition Button : 새로운 커스텀 컴포지션을
추가합니다.

• 컴포지션 추가 버튼 Add New Page Button :새로운컴포지션을추가합니다.

• 그룹 추가 버튼 Add New Group Button :새로운컴포지션그룹을추가합니다.

• 삭제 버튼 Delete Button :선택된컴포지션이나그룹을삭제합니다.

7.4 참고사항 References

위젯/파일/그룹이름수정

각 선택된 셀에서 엔터/탭키를 이용하여 수정모드로들어갈 수있습니다.페이지/컴포지션에서 기본이름으로 정
해진페이지/컴포지션은이름을수정할수없습니다.그밖에도아래에이름에사용할수없는단어들이나열되어
있습니다.

주석: id / ifdef / default -이단어들은네이밍에사용할수없습니다.
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CHAPTER 8

캔버스 Canvas

캔버스는아이유에디터에서작업하는화면을말합니다.위젯이나섹션을추가할수있으며,수정한내용이바로바
로보여집니다.
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8.1 컨텍스트메뉴 -단일위젯 Context Menu - Single Widget

위젯을선택한상태이거나,캔버스상에서우클릭을하면,컨텍스트메뉴를호출할수있습니다.

• 위젯 Widget :현재마우스포인터위치에있는모든위젯을보여주어선택을손쉽게할수있도록도와줍
니다.

• 메모 추가 Add Memo :현재선택된위젯에메모를추가할수있는메모패널 을불러옵니다.

• 위젯 내보내기 Export to Widget :현재선택된위젯을커스텀위젯 Custom Widget으로만들수있는
위젯내보내기패널 을호출합니다.

• 이벤트 보기 Show Event : 현재 선택된 위젯에 연결된 이벤트를 수정 / 추가 할 수 있는 이벤트 패널 을
불러옵니다.

• 탭 선택 Select Tab :원하는속성탭 으로바로이동합니다.
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8.2 컨텍스트메뉴 -복수위젯 Context Menu - Multiple Widget

복수의위젯을선택한상태에서우클릭을하면,컨텍스트메뉴를호출할수있습니다.

• 정럴 Align :현재선택된위젯들을정렬하는기능입니다.좌측정렬 Align Left,중앙정렬 Align Center,
우측 정렬 Align Right, 상단 정렬 Align Top, 세로 중앙 정렬 Align Middle, 하단 정렬 Align Bottom 이
있습니다.

• 크기 Size : 현재 선택된 위젯들의 크기를 맞추어 주는 기능입니다. 가로 맞춤 Match Width, 세로 맞춤
Match Height가있습니다.

8.2. 컨텍스트메뉴 -복수위젯 Context Menu - Multiple Widget 23
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CHAPTER 9

개발자모드 Developer Mode

상단툴바에서모드 변경 버튼을클릭하면개발자모드로전환할수있습니다.

개발자모드로 바꾸면 오른쪽에 코드 패널 이 나타납니다. HTML ID / 커스텀 코드 Custom Code 영역으로 구분됩
니다.

25



Sphinx RTD theme demo Documentation,출시 2.1.2

9.1 HTML ID

위젯의HTML ID를변경할수있습니다. Export HTML ID체크박스가있습니다. HTML ID는 Preference - Project
에서항상내보낼지,선택된위젯만내보낼지기본설정을변경할수있습니다.

9.2 커스텀코드 Custom Code

캔버스에서선택된위젯에백엔드, custom css, script코드를입력할수있습니다.위젯과프로젝트타입에따라탭
구성이달라집니다.
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CHAPTER 10

프로토타입모드 Prototype Mode

상단툴바에서 Mode Switch Button을눌러 Prototype Mode로전환할수있습니다.

여러명이하나의프로젝트를같이작업할때,프로토타입모드에서프로젝트와관련된히스토리와워크플로우,메
모등을공유하고관리할수있습니다.프로토타입모드는히스토리 Revision History /워크플로우 Project Workflow
/화면정의 Node Description세가지페이지를제공합니다. Refresh Workflow버튼은워크플로우를초기상태
로리셋시킵니다. Build Scenario버튼은프로토타입문서를 HTML Prototype으로빌드합니다. Refresh
Thumbnail 버튼을 누르면 워크플로우와 페이지 리스트에 있는 페이지 섬네일들을 최신상태로 업데이트 시킵
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니다.

10.1 히스토리 Revision History

프로젝트의히스토리 Revision History를보여줍니다.히스토리를변경하거나추가할수있습니다.

• Add New Date Button :히스토리테이블에새히스토리를추가합니다.

• Remove Date Button :히스토리테이블에서선택된히스토리를지웁니다.

10.2 워크플로우 Project Workflow

프로젝트의 워크플로우 Workflow 를 보여줍니다. 섬네일을 드래그 앤 드롭 하여 노드를 추가할 수 있습니다.
Delete키를눌러선택된노드를지울수있습니다.

• Default thumbnails :프로젝트에포함된페이지들의섬네일목록.

• Custom thumbnails : Page Capture버튼으로캡쳐된페이지들의섬네일목록.

주석: 커스텀섬네일은 Editor Mode에서툴바의 Page Capture를눌러추가할수있습니다.
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• Rectangle Button :선택된노드아래에사각형다이어그램을추가합니다.

• Rhombus Button :선택된노드아래에다이아몬드다이어그램을추가합니다.

• Inward Label :선택된노드위에표시되는텍스트를입력합니다.

• Outward Label :선택된노드아래에표시되는텍스트를입력합니다.

10.3 개별화면정의 Node Definition

각페이지의개별화면정의 Node Definition화면을보여줍니다.화면정의 Screen description과기타사항 Excep-
tion area에 내용을 추가하고 편집할 수 있습니다. 워크플로우 화면에서 섬네일을 더블클릭 해도 개별 화면 정의
Node Definition로넘어갑니다.

• 메모 이미지 추가 영역 :리소스패널에서메모넘버링을대체할이미지를선택합니다.

• Add Memo Button :메모테이블에새메모를추가합니다.

• Delete Button :메모테이블에서선택된메모를지웁니다.

스크린샷영역을클릭하면클릭한지점에메모를표시할수있습니다.

10.3. 개별화면정의 Node Definition 29



Sphinx RTD theme demo Documentation,출시 2.1.2

30 Chapter 10. 프로토타입모드 Prototype Mode



CHAPTER 11

프로젝트셋팅 Project Setting

프로젝트 > 프로젝트 셋팅 메뉴를 실행하거나 ⇧P 키를 실행하면 프로젝트 셋팅 패널이 보여집니다. 디폴트 De-
fault ,메타 Meta,빌드 Build,장고 Django탭메뉴를눌러각항목의내용을추가하거나수정할수있습니다.

11.1 디폴트 Default
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• Project Title :브라우져에서보여질프로젝트의타이틀을입력합니다.

• Favicon :파비콘이미지를설정합니다.리소스로불러들여온후에사용이가능합니다.

• Custom Header Code :프로젝트내모든페이지에공통으로적용될커스텀코드를입력합니다.

주석: Project Default Width는프로젝트생성이후에는변경이불가능합니다.

11.2 메타 Meta

• Meta Image :메타이미지를설정합니다.외부경로 (URL)만입력가능합니다.

• Author :메타데이타에포함될제작자의이름을입력합니다.

• Project URL :메타데이타에포함될프로젝트의 URL경로를입력합니다.

• Project Keywords : 메타데이타에 포함될 프로젝트의 키워드를 입력합니다. (복수 입력 가능 / 엔터나
콤마로구분)

• Project Description :메타데이타에포함될프로젝트설명을입력합니다.

• Facebook Admin :메타데이타에포함될페이스북어드민아이디를입력합니다.

• Facebook App ID :메타데이타에포함될페이스북앱아이디를입력합니다.
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11.3 빌드 Build

• Build Path :빌드실행시생성되는폴더의경로를설정합니다.

• Build Resource Path :빌드실행시생성되는리소스폴더의경로를설정합니다.

• Resource Prefix :프로젝트가사용할리소스폴더의경로를설정합니다.

• Link Prefix :프로젝트가사용할링크의경로를설정합니다.

• HTML Port :프로젝트가사용할로컬호스트서버의포트를설정합니다.

주석: 프로젝트가 사용하는 주소가 루트 패스 root path 가 아닐 경우, 리소스 프리픽스와 링크 프리픽스 경로를
수정해야합니다.

11.3. 빌드 Build 33
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11.4 장고 Django

주석: 장고셋팅은장고프로젝트 에서만설정가능합니다.

• Django Build Path :빌드실행시생성되는장고폴더의경로를설정합니다.

• Django Resource Path :빌드실행시생성되는장고리소스폴더의경로를설정합니다.

• Django Resource Prefix :장고프로젝트가사용할리소스폴더의경로를설정합니다.

• Runserver after build :빌드실행이후에로컬호스트서버실행여부를설정합니다.

• Django Port :장고프로젝트가사용할로컬호스트서버의포트를설정합니다.

• Python Interpreter Path :장고프로젝트가사용하는파이썬인터프리터의경로를설정합니다.

• Django Manage.py Path :장고프로젝트가사용하는Manage.py파일의경로를설정합니다.
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CHAPTER 12

프로젝트코드 Project Code

프로젝트코드버튼 Project > Project Code ⇧C을눌러프로젝트코드패널을불러올수있습니다.

해당코드는모든페이지에들어갑니다.

12.1 HTML

1 <head>
2 <!-- start : your code -->
3 <!-- auto generated code by IUEditor -->
4 <!-- end : your code -->
5 </head>
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12.2 Back-end

1 <!-- page head custom code for back-end : your code -->
2 <!DOCTYPE html>
3 <head>
4 <!-- start : your code -->
5 <!-- auto generated code by IUEditor -->
6 <!-- end : your code -->
7 </head>
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CHAPTER 13

리소스패널 Resource Panel

리소스패널은아이유에디터메뉴 View > Resource항목을활성화시키면등장합니다. Image, Video같은사용자
리소스를 추가, 관리할 수 있습니다. 아이유에디터에서 제작 불가능한 이미지나 동영상 요소, 클립아트를 불러올
수있는패널입니다.임포트가능한파일종류는이미지파일,동영상파일,자바스크립트, css, json이있습니다.

주석: Supported Image File Types : gif, jpg, jpeg, png, ico, icns, svg, bmp

주석: Supported Video File Types : mp4, ogg, webm
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• Import Resource Button :파인더를통해외부리소스를불러옵니다.

• Resource Type Select Button :리소스패널에있는파일을모두보기 /이미지보기 /동영상보기
로필터링하여줍니다.

• Add New Folder Button :리소스패널에새로운폴더를생성합니다.

• Delete Button :선택한파일또는폴더를삭제합니다.

13.1 리소스관리팁 Resource Management Tip

• 폴더를생성하여리소스를관리할수있습니다.

• 이미지리소스를이미지위젯에드래그 &드롭하여넣을수있습니다.
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CHAPTER 14

이벤트패널 Event Panel

이벤트패널은아이유에디터메뉴View > Event항목을활성화시키면등장합니다.스크롤애니메이터,베리에이블
트리거같은이벤트를추가할수있습니다.
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14.1 스크롤애니메이터 Scroll Animator

세로로 긴 웹페이지를 스크롤 하게 될 경우, 선택한 요소들에 대한 애니메이션 이벤트를 추가합니다. 스크롤 애
니메이터는해당요소가브라우저중앙에근접할수록 After값에가까워집니다.그래서페이지를스크롤해서해당
요소에포커싱될때 Before값에서 After값으로조정됩니다.

• X-Position : X위치값에대한애니메이션을추가합니다.

40 Chapter 14. 이벤트패널 Event Panel



Sphinx RTD theme demo Documentation,출시 2.1.2

• Y-Position : Y위치값에대한애니메이션을추가합니다.

• Opacity : Opacity투명도값에대한애니메이션을추가합니다.

14.2 베리에이블 Variable

14.2. 베리에이블 Variable 41
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선택된위젯에특정액션이발생되도록 (롤오버 or클릭)변수값과옵션을설정합니다.

• Variable Name :현재페이지에설정된모든 Variable리스트를보여줍니다. row를클릭하면해당 Vari-
able을사용하는 Triggered Widget리스트를볼수있습니다. Variable을사용하는Widget이없으면 Variable
Name리스트에서삭제됩니다.

• Triggered Widget : Variable Name에서선택한 Variable을사용하는 Triggered Widget리스트를보여줍
니다. row를클릭하면해당위젯으로포커스가이동합니다. row를선택한후, delete키(키보드)를누르거
나 New Variable Name에서삭제하면 Triggered Widget리스트에서삭제됩니다.

• New Variable Name :트리거의변수값을설정합니다. ID나 Name과같은역할을합니다.

• Value Count :트리거의초기값과,최대몇개의리시버를가질지최대값을설정합니다.

• Trigger Action :마우스오버또는클릭시트리거가동작하도록설정합니다.
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14.3 리시버 Receiver

트리거메뉴에서정의한변수가 Equation의조건과일치하게될경우,리시버가설정된위젯을보여줍니다.

• Variable Name :현재페이지에설정된모든 Variable리스트를보여줍니다. row를클릭하면해당 Vari-
able을 사용하는 Receiver Widget 리스트를 볼 수 있습니다. 예를 들어, a라는 Variable을 선택하면 a==1,
aa==1, 1==abc와같은 a가포함된 Equation을갖는위젯들을보여줍니다. Variable을사용하는Widget

14.3. 리시버 Receiver 43
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이없으면 Variable Name리스트에서삭제됩니다.

• Receiver Widget : Variable Name에서선택한 Variable을사용하는 Receiver Widget리스트를보여줍니
다. row를클릭하면해당위젯으로포커스가이동합니다. row를선택한후, delete키(키보드)를누르거나
Equation에서삭제하면 Receiver Widget리스트에서삭제됩니다.

• Equation : Trigger에서지정한변수에대한조건식을지정합니다.예시) a==1

• Scroll Location : Receiver 위젯의 Equation이 만족했을 때, 위젯이 보여지는 스크롤 위치를 지정하
는 옵션입니다. 옵션을 지정하면 Start와 End사이에 스크롤이 위치했을 때에만 보여지고, 옵션을 지정하지
않으면스크롤위치와상관없이보여지게됩니다.

• Animation Effect : Receiver위젯이보여질때나타나는애니메이션효과입니다.

• Duration : Animation Effect가실행되서끝날때까지의시간입니다.예를들어, 3.0s를입력하면Animation
Effect가 3초동안실행됩니다.
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CHAPTER 15

메모패널 Memo Panel

메모패널은아이유에디터메뉴 View > Memo항목을실행시키면등장합니다.선택된위젯에부가설명을추가할
때사용됩니다.
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• Show / Hide Table Toggle Button :현재페이지에서추가된모든메모를볼수있는테이블뷰를
숨김 /보임시킬수있는토글버튼입니다.

• Title :타이틀을입력합니다.

• Memo :내용을입력합니다.

주석: 메모테이블뷰에서는각메모의넘버 /타이틀 /내용을수정할수있습니다.

46 Chapter 15. 메모패널 Memo Panel



CHAPTER 16

커스텀위젯관리패널 Manage Custom Widgets Panel

위젯불러오기패널은아이유에디터메뉴 Project - Manage Custom Widgets항목을실행하면등장합니다.사용
자가 내보내기 Export 한 커스텀 위젯 Custom Widget, 페이지 Page, 컴포지션 Composition 파일을 프로젝트에
추가할때사용됩니다.그리드뷰의확대/축소보기모드가지원되며,우측에서커스텀위젯정보 Custom Widget
Information를수정할수있습니다.패널상단의토글버튼으로상세화면을열고닫을수있습니다.
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16.1 상단바 Top Bar

• Widget Tab :불러오기한위젯의목록을관리하고내보내기한커스텀위젯을불러옵니다.

• Page Tab :불러오기한페이지의목록을관리하고내보내기한페이지를불러옵니다.

• Composition Tab :불러오기한컴포지션의목록을관리하고내보내기한컴포지션을불러옵니다.

• Widget Info Toggle Button :커스텀위젯정보 Custom Widget Information를껐다켤수있는토글
버튼입니다.

• Search Bar :커스텀위젯의이름을검색할수있습니다.

16.2 위젯그룹리스트Widget Group List

패널 좌측에는 커스텀 위젯의 그룹 리스트가 보여집니다. 각 그룹을 선택하면, 그룹에 해당되는 커스텀 위젯들만
커스텀위젯리스트 Custom Widget List에서볼수있습니다.

16.3 커스텀위젯리스트 Custom Widget List

패널중앙에는선택된그룹에해당되는커스텀위젯들이보여집니다.

• Import :커스텀위젯파일을불러옵니다.

• Refresh :리스트를새로고침합니다.

• Open Folder :커스텀위젯파일폴더로이동합니다.

16.4 커스텀위젯정보 Custom Widget Information

패널우측에는선택된커스텀위젯의정보가보여집니다.

• Preview :커스텀위젯의프리뷰를보여줍니다.

• Zoom In / Out :프리뷰화면을줌인 /아웃시킵니다.

• Name :커스텀위젯의파일명입니다.

• Group :커스텀위젯의그룹명입니다.

• Tag :커스텀위젯에추가된태그목록입니다.클릭하여편집할수있습니다.

• Description :커스텀위젯의상세설명입니다.클릭하여편집할수있습니다.
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CHAPTER 17

위젯내보내기패널 Export Widget Panel

위젯내보내기패널은

• 스트럭쳐나캔버스에서특정위젯을선택하여컨텍스트메뉴 >위젯내보내기 Export Widget실행

• 페이지를선택하여컨택스트메뉴 >페이지내보내기 Export Page실행

• 컴포지션을선택하여컨텍스트메뉴 >컴포지션내보내기 Export Composition실행

하여불러올수있습니다.
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• Customize Viewport Size :커스텀파일의뷰포트를원하는사이즈로조정합니다.

• Name :커스텀파일의이름을입력합니다.

• New Group :커스텀파일의그룹을입력합니다.

• Export Directory :커스텀파일을내보낼경로를설정합니다.

• Description :커스텀파일에설명을입력합니다.

17.1 위젯내보내기 Export Widget (.iuw)

위 1) 상황에서 내보내기 Export 기능을 실행 하면, 로컬디스크에는 커스텀위젯이름.iuw 파일이 생성됩니다. 이
파일은위젯불러오기패널 에서불러온후에사용가능합니다.

17.2 페이지내보내기 Export Page (.iup)

위 2) 상황에서 내보내기 Export 기능을 실행 하면, 로컬디스크에는 커스텀페이지이름.iup 파일이 생성됩니다.
이파일은네비게이션 -페이지탭 에서커스텀 페이지 추가 버튼으로불러올수있습니다.
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17.3 컴포지션내보내기 Export Composition (.iuc)

위 3) 상황에서 내보내기 Export 기능을 실행 하면, 로컬디스크에는 커스텀위젯이름.iuc 파일이 생성됩니다. 이
파일은네비게이션 -컴포지션탭 에서커스텀 컴포지션 추가 버튼으로불러올수있습니다.

17.3. 컴포지션내보내기 Export Composition (.iuc) 51
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CHAPTER 18

프로젝트타입 Project Type

18.1 디폴트프로젝트 Default Project

백엔드가연결되지않는프로젝트타입입니다.파일 >새프로젝트를실행하여새프로젝트창을열어선택할수
있습니다.

resource/iu_manual_project_new_default.png

• Empty Page (Header / Footer) : 빈 레이아웃 (헤더 + 페이지 컨텐트 + 푸터) 프로젝트를 생성합
니다.

• Empty Page (Header) :빈레이아웃 (헤더 +페이지컨텐트)프로젝트를생성합니다.

• Empty Page (Blank) :빈레이아웃 (페이지컨텐트)프로젝트를생성합니다.

• IUPro : IUPro템플릿프로젝트를생성합니다.

• Paper : IUPaper템플릿프로젝트를생성합니다.
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• IUAcademy : IUAcademy템플릿프로젝트를생성합니다.

• Recent Project :최근사용했던 (최대 5개)프로젝트목록입니다.

• Open Project :사용할프로젝트를직접선택합니다.

주석: 빈레이아웃프로젝트를선택시,새프로젝트창하단에서프로젝트의기본너비를설정할수있습니다.

18.2 장고프로젝트 Django Project

백엔드가연결되는프로젝트타입입니다.파일 >새프로젝트를실행하여새프로젝트창을열어선택할수있습
니다.

사용가능한메뉴는디폴트프로젝트와동일합니다.

resource/iu_manual_project_new_django.png

18.3 Angular JS프로젝트 Angular JS Project

백엔드가연결되는프로젝트타입입니다.파일 >새프로젝트를실행하여새프로젝트창을열어선택할수있습
니다.

사용가능한메뉴는디폴트프로젝트와동일합니다.

resource/iu_manual_project_new_angularjs.png
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CHAPTER 19

페이지 Page

19.1 페이지세팅 Page Setting

페이지에는직접적으로위젯을삽입할수없습니다.먼저페이지설정버튼을눌러페이지세팅패널을통해,페이
지의레이아웃을정한후각각해당하는곳에위젯을삽입합니다.
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• Empty Layout :빈레이아웃입니다.

• Header + Footer :헤더 +페이지컨텐트 +푸터로구성되어있습니다.

• Header :헤더 +페이지컨텐트로구성되어있습니다.

• Footer :페이지컨텐트 +푸터로구성되어있습니다.

• 페이지타이틀 Page Title :현재페이지의타이틀을입력합니다.

• 페이지키워드 Page Keyword :현재페이지의키워드를입력합니다. (여러키워드입력가능)

• 페이지설명 Page Description :현재페이지의페이지설명을입력합니다.

• 페이지메타이미지 Page Meta Image :현재페이지의메타이미지경로를입력합니다. (URL을입력)
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19.2 페이지커스텀코드 Page Custom Code

• Page Header Custom Code :페이지헤더 Header부분에추가할커스텀코드를입력합니다.

• Page Header Custom Code for Backend :페이지헤더 Header부분에추가할백엔드커스텀코드를입력합
니다.

19.3 페이지기본위젯 Page Default Widget

19.3.1 페이지 Page

페이지는 html문서와동일하며,속성탭에서페이지구조를변경할수있습니다.
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19.3.2 헤더 Header

페이지의상단에위치하는영역입니다.헤더영역에는헤더컴포지션이나다른컴포지션을임포트할수있습니다.

19.3.3 페이지컨텐트 Page Content

페이지의본문컨텐츠영역입니다.페이지컨텐트요소는삭제불가능하며,하위요소로섹션을추가할수있습니다.

19.3.4 푸터 Footer

페이지의하단에위치하는영역입니다.푸터영역에는푸터컴포지션이나다른컴포지션을임포트할수있습니다.

19.3.5 섹션 Section

페이지컨텐트의하위요소인섹션입니다.섹션에는위젯을자유롭게추가할수있습니다.

19.3.6 센터박스 Centered Box

섹션이생성되면자동으로추가되는위젯요소입니다.페이지의요소를가운데로정렬시키기위해사용됩니다.사
이즈나위치조절이불가능하며,너비는작업중인미디어쿼리사이즈를따라갑니다.가운데정렬이불필요할때는
삭제해도무관합니다.
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19.3.7 패널 Panel

패널 그룹의 + 버튼을 눌러 패널을 추가합니다. 패널을 호출하려면 위젯과 링크를 생성하고 패널에 대한 링크
대상을선택해야합니다.

19.3.8 팝업 Popup

팝업 그룹의 + 버튼을 눌러 팝업을 추가합니다. 팝업을 호출하려면 위젯과 링크를 생성하고 팝업에 대한 링크
대상을선택해야합니다.

19.3. 페이지기본위젯 Page Default Widget 59
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CHAPTER 20

컴포지션 Composition

반복되는위젯의조합을 Composition내에서구성하여 Import/Header/Footer/Collection에서사용할수있습니다.
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CHAPTER 21

기본위젯 Basic Widget

21.1 박스 Box

가장기본적인위젯이며 <div>태그로생성됩니다.주로레이아웃을설정하는데에사용되며하위요소를묶어주
는그룹용도로도사용됩니다.

속성

• 하위요소 :가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능

21.2 텍스트 Text
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텍스트위젯입니다. <p>태그로생성되며 Text탭에서 <h1>혹은 <h2>태그로변경할수있습니다.텍스트위젯을
생성하고 더블클릭하면 텍스트를 입력할 수 있으며, 그 상태에서 한번 더 더블클릭하면 부분편집모드로 변경됩
니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :가능

21.3 이미지 Image

이미지 위젯입니다. 라이브러리에 추가한 이미지를 선택하거나, 이미지 URL을 직접 입력해 불러올수 있습니다.
Fit widget size to image size 버튼을 누르면 불러온 이미지 사이즈에 맞춰 위젯 사이즈가 자동으로 변경됩니다.
위젯영역내에서이미지의사이즈와정렬상태을변경할수있습니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능

21.4 스태틱이미지 Static Image
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스태틱이미지위젯입니다.라이브러리에추가한이미지를선택하거나,이미지 URL을직접입력해불러올수있습
니다. Fit widget size to image size버튼을누르면불러온이미지사이즈에맞춰위젯사이즈가자동으로변경됩니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :가능

21.5 셀 Cell

텍스트가자동으로중앙정렬되어있는위젯입니다.위젯의높이 H는픽셀 px단위만사용할수있습니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :가능

21.6 아이콘버튼 Icon Button

셀위젯에이미지를추가할수있는아이콘버튼위젯입니다.이미지와텍스트가자동으로중앙정렬되고,이미지의
크기,위치좌우배치등을변경할수있습니다.

속성

• 하위요소 :불가능

• 링크 :가능
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• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :가능

66 Chapter 21. 기본위젯 Basic Widget



CHAPTER 22

복합위젯 Complex Widget

22.1 트랜지션 Transition

트랜지션위젯입니다.트랜지션위젯은하위에 2개의아이템을가지고있으며,클릭혹은마우스오버시 1번아이
템에서 2번아이템으로전환됩니다. Effect와 Duration을설정해다양하게커스터마이징가능합니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능

22.2 캐러젤 Carousel
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캐러젤 위젯입니다. 하위 아이템은 Box와 속성이 동일하므로 자유롭게 요소를 추가할수 있습니다. Property에서
아이템개수를추가하거나컨트롤러나오토플레이등의옵션을설정할수있습니다.

속성

• 하위요소 :불가능

• 링크 :내부요소에만가능

• 스크롤애니메이터 :불가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능

22.3 구글맵 Google Map

구글맵위젯입니다.좌표값을설정하면원하는위치를보여줄수있습니다.

컬러스타일이나,줌설정등다양하게커스터마이징할수있습니다.

주석:

1) 에디터모드에서는미리보기가 600x600사이즈로만지원되지만아웃풋모드에서는정상작동합니다.

2) 대한민국지도에는컬러테마가적용되지않습니다.

속성

• 하위요소 :불가능

• 링크 :불가능

• 스크롤애니메이터 :가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능

22.4 웹무비WebMovie
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웹무비 위젯입니다. Vimeo와 Youtube에 업로드 된 영상을 불러올 수 있습니다. 영상을 불러올때는 다음과 같이
짧은주소를이용합니다.

• Vimeo : http://vimeo.com/videoURL

• Youtube : http://youtu.be/videoURL

자동재생/자동반복등의설정이가능합니다.

속성

• 하위요소 :불가능

• 링크 :불가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능

22.5 비디오클립 Video Clip

비디오클립위젯입니다.리소스패널에서비디오를입력할수있습니다.

Property

• Child : Invalid

• Link : Valid

• Scroll Animator : Valid

• Background Image : Valid

• Backend Ellipsis : Invalid

22.6 테이블 Table

22.5. 비디오클립 Video Clip 69
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테이블위젯입니다.캔버스에간단한표를그릴수있습니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :가능

22.7 심플탭 Simple Tab View

탭뷰위젯입니다.탭뷰위젯보다구조가단순합니다.탭선택시각각의탭에연결된탭컨텐츠를보여줍니다.

속성

• 하위요소 : -

• 링크 : -

• 스크롤애니메이터 : -

• 배경이미지 : -

• 백엔드엘립시스 : -

22.8 탭뷰 Tab View

탭뷰위젯입니다.탭선택시각각의탭에연결된탭컨텐츠를보여줍니다.

속성

• 하위요소 : -
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• 링크 : -

• 스크롤애니메이터 : -

• 배경이미지 : -

• 백엔드엘립시스 : -

22.9 컬랩시블 Collapsible

컬랩시블위젯입니다.컬랩시블아이템을선택시컨텐츠영역을보여줍니다.트랜지션효과와타이밍등을설정할
수있습니다.

속성

• 하위요소 : -

• 링크 : -

• 스크롤애니메이터 : -

• 배경이미지 : -

• 백엔드엘립시스 : -

22.10 임포트 Import

컴포지션을불러오는임포트위젯입니다.헤더또는푸터그리고커스텀컴포지션요소를임포트할수있는위젯
입니다.하나의컴포지션을여러개의임포트에불러올수있어다양한응용이가능합니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능
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22.11 트위터공유버튼 Tweet Share Button

현재페이지를트위터로공유할수있는트위터위젯입니다. Property에서형태를설정할수있으나크기는조정되
지않습니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능

22.12 페이스북좋아요버튼 Facebook Like Button

현재페이지를페이스북으로공유할수있는페이스북위젯입니다. Property에서공유할 URL의주소와컬러테마
를설정할수있으나크기는조정되지않습니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능

22.13 센터박스 Centered Box
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페이지의요소를가운데로정렬시켜주는센터박스위젯입니다.섹션에는자동으로추가되지만,필요시다른요소
에추가할수있도록위젯으로도만들어져있습니다.센터박스크기는가로:미디어쿼리값,세로:100%로고정되어
있으며변경은불가능합니다.이외의속성은일반 Box위젯과동일합니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능

22.14 프로그레스바 Progress Bar

최대치대비현재비율을나타태주는프로그레스바를그릴수있는위젯입니다.프로그레스바의크기와컬러를
자유롭게선택가능하며,줄무늬나움직임등옵션을설정할수있습니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능

22.15 SVG (Scalable Vector Graphics)
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SVG를 사용할 수 있는 위젯입니다. 아이유에디터에서는 메뉴, 검색, 체크, 좌/우 화살표 등의 형태를 기본으로
제공합니다. Property에서배경컬러,스트로크컬러등을설정할수있으며,외부에서그린 SVG이미지의코드를
붙여넣어원하는형태를사용할수도있습니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능
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CHAPTER 23

프로그래밍위젯 Programming Widget

23.1 폼 Form

폼위젯입니다. Input요소를감싸주는 <form>태그위젯입니다.따라서, Input요소를추가하기전에필수로생성
해야합니다.폼위젯을먼저만들고그안에 Input위젯을넣어주세요.

속성

• 하위요소 :가능

• 링크 :불가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능

23.2 인풋텍스트 Input Text

75



Sphinx RTD theme demo Documentation,출시 2.1.2

인풋텍스트위젯입니다. Form위젯에추가하여사용자로부터텍스트를입력받을수있습니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능

23.3 인풋패러그래프텍스트 Input Paragraph Text

인풋 텍스트(문장) 위젯입니다. Form 위젯에 추가하여 사용자로부터 텍스트를 입력받을수 있습니다. (긴 문장에
사용)

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능

23.4 셀렉트 Select

셀렉트 위젯입니다. Form 위젯에 추가하여 사용자로부터 특정 값을 입력받을수 있습니다. (여러 개의 옵션 중
선택된 1개의값을받아올경우사용)
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속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능

23.5 HTML (Hyper Text Markup Language)

HTML 위젯입니다. IUEditor에 원하는 위젯이 없을 경우 직접 HTML 코드를 작성해서 넣을 수 있습니다. 하지만
원하는위젯이있다면 iu@jdalb.org로의견을보내주세요!

속성

• 하위요소 :불가능

• 링크 :불가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능

23.6 콜렉션 Collection

컴포지션을 불러오는 콜렉션 위젯입니다. 하나의 컴포지션을 반복해서 사용하려고 할때 유용합니다. 한 줄에 몇
개의컴포지션이보이게할지정할수있습니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능
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• 배경이미지 :가능

• 백엔드엘립시스 :불가능

23.7 페이지넘버셋 Page Number Set

페이지링크셋위젯입니다.콜렉션뷰로불러온다수의요소를페이지단위로제어하고싶을때사용합니다.주로
게시판이나페이지세트의링크를만들때사용합니다.한번의몇개의숫자를나타낼것인지정할수있습니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능

23.8 체크박스 Checkbox

체크박스위젯입니다.기본형태의체크박스위젯입니다.사용자가원하는만큼여러개의위젯을자유롭게배치할
수있습니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능
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23.9 라디오버튼 Radio Button

라디오버튼위젯입니다.기본형태의라디오버튼위젯입니다.사용자가원하는만큼여러개의위젯을자유롭게
배치할수있습니다.

속성

• 하위요소 :불가능

• 링크 :가능

• 스크롤애니메이터 :가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능

23.10 버튼 Button

버튼 위젯입니다. Default / Reset / Submit 3 가지 타입 중에 1가지를 선택해서 사용합니다. Form에서 입력받은
내용을전송하는기능을담당합니다.

속성

• 하위요소 :불가능

• 링크 :불가능

• 스크롤애니메이터 :가능

• 배경이미지 :가능

• 백엔드엘립시스 :불가능

23.11 파일업로드 File Upload
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파일업로드위젯입니다.업로드버튼을선택하여서버로올릴파일을선택할수있습니다. (1개의파일)

속성

• 하위요소 :불가능

• 링크 :불가능

• 스크롤애니메이터 :가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능

23.12 스위치 Switch

스위치위젯입니다.스위치를토글하여 ON-OFF상태로변경할수있습니다.

속성

• 하위요소 :불가능

• 링크 :불가능

• 스크롤애니메이터 :가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능

23.13 플립스위치 Flip Switch

플립스위치위젯입니다.플립스위치를토글하여 ON-OFF상태로변경할수있습니다.

속성

• 하위요소 :불가능
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• 링크 :불가능

• 스크롤애니메이터 :가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능

23.14 슬라이더 Slider

슬라이더위젯입니다.슬라이더를선택하여원하는값을입력하거나,수치를입력하여슬라이더를조정할수있습
니다.

속성

• 하위요소 :불가능

• 링크 :불가능

• 스크롤애니메이터 :가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능

23.15 레인지슬라이더 Range Slider

레인지 슬라이더 위젯입니다. 레인지 슬라이더의 포인터를 이동시켜 원하는 값을 입력하거나, 수치를 입력하여
슬라이더를조정할수있습니다.

속성

• 하위요소 :불가능

• 링크 :불가능

• 스크롤애니메이터 :가능

• 배경이미지 :불가능

• 백엔드엘립시스 :불가능
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CHAPTER 24

알려진버그

현재버젼까지의버그리스트입니다.사용에참고부탁드립니다.

24.1 이벤트패널 -스크롤애니메이터

원칙적으로스크롤애니메이터는포지션이 Absolute상태에서만입력이가능합니다만,간혹 Relative상태에서도
입력이가능한경우가발생합니다.

24.2 이벤트패널 -사용불가능한변수명

변수명에는언더바(_)를제외한특수문자를사용할수없습니다. (~,!,@,#,$,%,^,&,*,+,?,=,...)또한,숫자도변수명
의맨앞에쓸수없습니다.

24.3 파일경로내 ’#’또는 ’@’문자가들어갈경우

IU파일이 위치한 폴더경로에 ’#’ 또는 ’@’ 문자가 들어갈 경우, 리소스 경로를 제대로 불러올 수 없습니다. 폴더
명에해당문자열사용을자제해주세요.
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CHAPTER 25

환경설정 Preference

IUEditor의사용환경을설정합니다.
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25.1 일반 General

• 탭 메뉴 Select Tab Menu :탭메뉴를상단툴바에서보이도록할지선택합니다.

• 가이드 라인 색 Guide Line Color :가이드라인색상을변경합니다. (가이드라인보기 : View > Guide
;)

• Custom Template List URL : 새 프로젝트 템플릿 목록에 커스텀 템플릿을 적용하기 위해 plist URL
을입력합니다.
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25.2 프로젝트 Project

• 세이브 옵션 Project Save Option : Minimize Data체크시프로젝트의 json파일을압축합니다.

• 컴파일 옵션 Compile Option

– Export HTML ID Option : HTML ID를 모든 위젯에 기본으로 생성되도록 할 것인지, 선택된 위
젯만 HTML ID를만들것인지선택합니다.

– Name on Structure : HTML문서에위젯이름을포함할것인지선택합니다.

• Resource Copy Option :커스텀위젯 Custom Widget을캔버스에추가할때중복되는리소스를어떻게
처리할지선택합니다.

• Widget Option :섹션을추가할때센터박스를기본으로포함되도록할것인지선택합니다.

25.3 폰트 Fonts

폰트리스트에새웹폰트를추가합니다.
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CHAPTER 26

템플릿 Templates

IUEditor에서사용할수있는템플릿의모음입니다.프로그램실행시첫화면에서볼수있습니다.

• IUPro

• IUPaper
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• IUAcademy
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CHAPTER 27

단축키 Shortcut

단축키에대한설명입니다.

27.1 프로젝트관리 Project Management

• Project Setting⇧P :프로젝트설정창을보여줍니다.

• Refresh⇧F :현재페이지를다시불러옵니다.

• Import Custom Widget⇧W :커스텀위젯패널을불러옵니다.

27.2 위젯추가 Add Widget

• IUBox 1 :캔버스에추가하기위해 IUBox위젯을선택합니다.

• IUText 2 :캔버스에추가하기위해 IUText위젯을선택합니다.

• IUImage 3 :캔버스에추가하기위해 IUImage위젯을선택합니다.

• IUStatic Image 4 :캔버스에추가하기위해 IUStatic Image위젯을선택합니다.

• IUCell 5 :캔버스에추가하기위해 IUCell위젯을선택합니다.

27.3 위젯사용Widget Control

• Copy C :선택한위젯을복사합니다.

• Paste V :복사한위젯을붙여넣습니다.

• Undo Z :실행한기능을되돌립니다.

• Duplicate D :선택한위젯을동일한레벨에복제합니다.
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• Redo⇧Z :언두한기능을다시실행합니다.

27.4 뷰관리 View Management

• Zoom In + :스페이지를확대합니다.

• Zoom Out - :스테이지를축소합니다.

• Widget Panel :위젯패널을보여주고감춥니다.

• Event Panel⇧E :이벤트패널을보여줍니다.

• Resource Panel⇧R :리소스패널을보여줍니다.

• Memo⇧M :메모패널을보여줍니다.

27.5 모드변경 Mode Switch

• 에디터 모드 Editor Mode [ :에디터모드 Editor Mode로전환합니다.

• 개발자 모드 Developer Mode ] :개발자모드 Developer Mode로전환합니다.

• 프로토타입 모드 Prototype Mode :kbd:‘‘ :프로토타입모드 Prototype Mode로전환합니다.

27.6 캔버스뷰관리 Canvas View Management

• Show Outline L :위젯의외곽요소를보여줍니다.

• Show Widget Info I :위젯의정보를보여줍니다. (추가된메모를나타냅니다.)

• Show Ruler R :스테이지에룰러요소를보여줍니다.

• Show Guide ; :설정해놓은가이드라인을보여줍니다.

• Tracing⇧T :이미지트레이싱기능을 on/off합니다.
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CHAPTER 28

용어 Dictionary

본메뉴얼에서사용된용어에대한설명입니다.

28.1 build

아이유에디터는 스테이지에서 보여지는 내용을 실제 사용가능한 파일로 생성하여 줍니다. 이 작업을 ’빌드를 실
행한다’라고표현합니다.

28.2 django

python web framework.

28.3 python

server-side programming language. ruby와더불어가장인기있는프로그래밍언어중하나입니다.

28.4 widget

아이유에디터에서는스테이지에추가되는모든요소들을위젯이라고표현합니다.
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CHAPTER 29

튜토리얼 Tutorials

IUEditor를배울수있는기본튜토리얼입니다.

튜토리얼사이트가기

• Tutorial 101 -블로그스타일웹페이지만들기

• Tutorial 201 -반응형매거진뷰만들기 Part1 -디자인

• Tutorial 202 -반응형매거진뷰만들기 Part2 -미디어쿼리
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